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Radio and television interference

The equipment described in this manual generates, uses, and can radiate radio-
frequency energy. Ifit is not installed and used properly—that is, in strict accordance
with Apple’s instructions—it may cause interference with radio and television reception.
This equipment has been tested and found to comply with the limits for a Class B digital
device in accordance with the specifications in Part 15 of FCC rules. These specifications
are designed to provide reasonable protection against such interference in a residential
installation. However, there is no guarantee that the interference will not occur in a
particular installation.

You can determine whether your computer system is causing interference by turning it

off. If the interference stops, it was probably caused by the computer or one of the

peripheral devices.

If your computer system does cause interference to radio or television reception, try to

correct the interference by using one or more of the following measures:

m Turn the television or radio antenna until the interference stops.

= Move the computer to one side or the other of the television or radio.

m  Move the computer farther away from the television or radio.

m  Plug the computer into an outlet that is on a different circuit from the television or
radlio. (That is, make certain the computer and the television or radio are on circuits
controlled by different circuit breakers or fuses.)

If necessary, consult your authorized Apple dealer or an experienced radio/television

technician for additional suggestions. You may find helpful the following booklet,

prepared by the Federal Communications Commission: frterference Handbook (stock
number 004-000-00345-4). This booklet is available from the U.S. Government Printing

Office, Washington, DC 20402,

2\ Important: Changes or modifications to this product not authorized by Apple
Computer, Inc., could void the FCC Certification and negate your authority to
operate the product.

This product was tested for FCC compliance under conditions that included the use
of shiclded cables and connectors between system components, It is important that
you use shielded cables and connectors to reduce the possibility of causing
interference to radios, television sets, and other electronic devices. For Apple
peripheral devices, you can obtain the proper shielded cables from your authorized
Apple dealer. For non-Apple peripheral devices, contact the manufacturer or dealer
for assistance.

Important

This equipment has been tested and found to comply with the limits for a Class B
digital device in accordance with the specifications in Part 15 of FCC rules. See
instructions if interference to radio or television reception is suspected.

DOC Class B Compliance This digital apparatus does not exceed the Class B limits
for radio noise emissions from digital apparatus st out in the radio interference
regulations of the Canadian Department of Communications.

Observation des normes—Classe B Le présent appareil numérique n'émet pas de
bruits radioélectriques dépassant les limites applicables aux appareils numériques de Ia
Classe B prescrites dans les réglements sur le brouillage radioélectrique édictés par le
Ministere des Communications du Canada.



Chapter 1

Getting Started

The StyleWriter 11 provides a fast, economical way for you to
produce high-quality printed text and gray-scale graphics. You can
load it with up to 100 sheets of paper or 15 envelopes at a time.
And if your Macintosh is connected to a network, you can share
your printer with other users.

The StyleWriter I works with Macintosh computers that use
system software version 7 or later. You can also use version 6.0.7
or later. You must have a hard disk drive to use the StyleWriter I1.
If you're new to the Macintosh, read the books that came with
your computer before proceeding. You'll need to know basic
operations and vocabulary before you set up and print with the
StyleWriter IL.

Your StyleWriter IT works with all fixed-size and TrueType fonts.
Truelype allows you to display and print fonts smoothly in
virtually any size. A number of Tru€lype font families (typefaces)
are included on the disks that came with your printer. These fonts
are automatically installed on your Macintosh when you follow the
directions in this chapter. For more information about using fonts,
see the books that came with your Macintosh or with your latest
system software update.



Important safety instructions

Read all the instructions in this chapter carefully before you plug
the StyleWriter 1l into an electrical outlet.

For your own safety and the safety of your equipment, always take
the following precautions:

)

Follow all instructions and warnings dealing with your system.

Keep the StyleWriter 1T away from sources of liquids, such as
wash basins, bathtubs, and shower stalls.

Protect the StvleWriter II from dampness or wet weather, such
as rain and snow.

Don't use devices that produce open flames, such as Bunsen
burners or welding torches, near the StyleWriter I1.

Don't use ammonia-hased or alcohol-hased cleaners, which
can react chemically with the plastic, on or around the
StyleWriter I1.
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Don't drink or swallow the ink. It's not toxic, but it's not for
human consumption. Keep ink cartridges away from children.

Avoid getting ink on your clothes. The ink will eventually wash
off your hands, but stains on fabrics or clothing are
permanent.

Keep these instructions handy for reference.

A Warning: Electrical equipment may be hazardous if misused.

Operation of the StyleWriter I or of similar products must
always be supervised by an adult. Do not allow children access
to the interior of any electrical product and do not permit
them to handle any cables. a



Aatch for these situations and if one occurs
pull the plug!

If you encounter any of these circumstances, disconnect the
power plug immediately! (Pull the plug, not the cord.)

s the power cord or plug is frayed or otherwise damaged
» vou spill anvthing into the case

w the StyleWriter ITis exposed to rain or any other excess
moisture

» the StyleWriter I has been dropped, or the case has been
otherwise damaged

m vou suspect that the StyleWriter IT needs servicing or repair
= you plan to clean the printer

If you suspect vour StyleWriter 11 is damaged, see the information
about service and support that came with it.

Set up your StyleWriter 11

You're ready to set up your StyleWriter IL If you haven't already
done so, unpack your printer and make sure you have everything
listed on your packing list.

Choose a location near your Macintosh computer that has a
grounded electrical outlet, and good ventilation, is out of direct
sunlight, and never gets damp, very hot, or very cold. The printer
works best at

= temperatures between 59° and 86° Fahrenheit (15°and 30°
Celsius)

m  relative humidity between 20 and 70 percent

See the appendix for more specific information about the physical
requirements of the printer.
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Connect the StyleWriter 11 to your Macintosh

No matter which Macintosh vou have,

To connect your StyleWriter Il to your Macintosh computer, you thesle icons identify the printer and
modem ports.

need a peripheral-8 cable.

Before you connect the StyleWriter 11 to your Macintosh, make
sure the computer is turned off. Then use a peripheral-8 cable to
connect the printer to the computer as shown. It doesn’t matter
which end of the cable you use first; both ends are the same.

A\ Important: It's OK to connect the StyleWriter II to either the
printer port or the modem port. &
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Install the ink cartridge

The ink cartridge contains the ink the printer uses. Each cartridge
lasts for several hundred pages, depending on the kind of printing
vou do.

1. Open the access door at the front of the printer.

Grasp the top corners of the
door and pull it toward vou.

The door flips down.

. Open the package containing your ink cartridge.
. Get the ink cartridge ready by following the

instructions that came with it.

. To install the cartridge, follow the instructions inside

the door of the printer.

. Close the access door.

Chapter 1: Getting Started 5



Plug in the StyleWriter 11

Connect the power cord to the StyleWriter I first, then plug the
other end of the cord into a grounded electrical outlet.

Insert the power cord into the receptacle
at the back of the StyleWriter I1.

Plug the power cord
into a grounded outlet.

&

(27
L
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A Warning: This equipment is meant o be electrically
grounded. Do not defeat the purpose of the grounding plug!
The StyleWriter I1 is equipped with a three-wire grounding
plug—a plug that has a third (grounding) pin. This plug fits
only a grounding-type AC outlet. If you are unable to insert
the plug into an outlet, contact a licensed electrician to
replace the outlet with a properly grounded one. A



Load paper into the sheet feeder 2. Load a stack of paper into the sheet feeder.

The sheet feeder holds up to 100 sheets of 20-Ib. paper and feeds Move the adjustable guide so that it just touches the edge of
the paper automatically into the printer. To load paper into the the paper. If the stack of paper bows out even slightly, the
sheet feeder, follow these steps: guide is too tight.

1. Raise the paper support as shown. Be careful not to overload the sheet feeder. The stack of paper

should not be higher than the indicator line on the right side

You can also open the output tray if you wish. of thesheet foeder:

Move the adjustable guide
to fit just against the paper.

Slide paper in, making sure it lines

Make sure lever is next up evenly at this side of the feeder.

to (1) paper icon.

Pull here if you want to
open the output tray.
Be sure to pull it out all the way.

Do not stack paper
above this line.
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Turn on the StyleWriter I and print the test page

For normal use you turn the printer on by pressing the power
button (marked with the @ icon). When you turn on the printer,
the amber error light (marked with the 84 icon) comes on for a
moment, then blinks off when you release the power button. The
green power light comes on and stays on.

To print a test page, start with the printer turned off. Press and
hold down the power button for several seconds, until the amber
error light goes out or the test page starts to print.

Error light

8  Chapter 1: Getting Started

The test page displays the version of the software built into the
StyleWriter 11. The test pattern printed below the picture of the
printer can indicate problems with the ink cartridge.

& Apple StyleWriter 11

This tells you which version
_ of read-only memory (ROM)
you have in your StvleWriter I1.

The pattern should look like
L this. If the print quality is not
| satisfactory, the ink cartridge
is not installed properly or
needs to be cleaned. See
“Cleaning the Ink Cartridge”
in Chapter 3.

Your StyleWriter II printer is ready to use. Next you need to get
your Macintosh ready by installing the software that lets it
communicate with the StyleWriter II.



Install your printer software

Before you install the printer software, you need to protect the
original disks by locking them:

Locked Unlocked

A\ Important: Before you install the printer software, turn off
any automatic virus detection programs you have on your
Macintosh computer. If you don't, problems may occur. After
installation is complete, you can turn the virus detection pro-
grams back on. A

Using the Installer

The StyleWriter Il comes with a program called the Installer that
installs printer software onto your hard disk. Follow these steps to
install the software:

1. Insert the StyleWriter II Installation disk into a floppy
disk drive.

The disk’s icon appears on the desktop.

2. Open the disk by double-clicking its icon.

(==

System Disk

Double-click this icon
E to open the disk.

Styledw'riter |l Installation

continues »
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3. Open the Installer by double-clicking its icon.

Double-click this
icon to open
the Installer.

Irztaller

When you open the Installer, it displays information about the
files to be installed. Click OK.

Important: If you see a message that the Installer cannot
install the printer software, you must upgrade your system
software before proceeding. You can purchase a system soft-
ware upgrade kit from an Apple dealer. A

. Click the Install button.

The Installer takes a few moments to calculate what needs to
be done and then begins to copy files. The whole process may
take several minutes.

Important: Some Macintosh computers come with
StyleWriter 1I software already installed. If you see a message
that StyleWriter II software is already installed on your hard
disk, you can quit the installation (by clicking the Quit button)
and turn to Chapter 2 to start using your printer. A

10 Chapter 1: Getting Started

5. When the StyleWriter II Installation disk is ejected, fol-

low the instructions you see on the screen.

You'll have to swap disks a few times. Each time, the Installer
ejects one disk and asks you to insert another. Keep following
the instructions on the screen until the installation is com-
plete.

When the installation is complete and you are ready to start
printing, turn to Chapter 2.



Chapter 2

Using your StyleWriter II

Before you can print documents on your StyleWriter I1, you need
to do three things first (vou do not need to do these things every
time you print):

= choose the printer in the Chooser
= define your page setup
s load paper, envelopes, or other material into the printer

To print a document (from an application program or from the
desktop) vou only need to do one thing to begin:

s choose Print from the File menu

If your computer is connected to other Macintosh computers over
a network, vou can also:

= share your printer with other users on the network
= use a printer someone else has shared on the network

This chapter tells you how to do all of these things.

Getting help

If you need more information about the choices presented on
your screen when vou use your StyleWriter 11, click the Help
button when you see it. If you are using System 7, vou can choose
Show Balloons from the Help menu.

About Balloon Help... \

If you use System 7. you can
choose Show Balloons from
the Help menu.

Help

When you see this button,
click it for more information.

11



Choosing a printer

Before you use your StyleWriter 11 for the first time, you must use
the Chooser to let the Macintosh know what printer you want to
use.

1. Choose the Chooser from the Apple (8) menu.

The Chooser window opens. (Your Chooser may not look
exactly like the illustration, but it should contain the same
elements.)

2. Set the Chooser options as shown here:

1 Click the StyleWriter ITicon.

= Chooser &=

[&] | Connect to:

- || [ —
@ <Serial Port>

&
i » Background Printing
S ®0n O ofrr

O Active On Restart
@ Inactive

(7| | AppleTalk

2 Click the top icon if you plugged the printer
into the printer port, or the bottom icon if
you plugged it into the modem port.
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3. Click the close box.

The Chooser closes.

A Important: You don't need to use the Chooser every time
vou print. If the StyleWriter I1is the only printer you're using,
this should be the only time you need to use the Chooser to
choose the printer. 2



Defining your page setup

You do not have to use Page Setup every time you print; the most
frequently used options are preset for you. To change your

printing options in the Finder or in an application program, follow

these steps:

1.

Choose Page Setup from the File menu.

The Page Setup dialog box appears. The dialog box you see
may not look exactly like the one shown here, but all Page
Setup dialog boxes have many features in common.

In the dialog box, make the selections you want.

To make your document print Choose a page Click here
larger or smaller, type or size from this for more
choose a percentage. pop-up menu. information.
Stylellriter Il Page Setup 1.0 m
L Page size:[ US ﬂa_iter v | [Cnncel ]
Scaling (%l:[@
“Orientation: m J :

Click one of these icons to choose
normal (portrait) or sideways
(landscape) orientation.

lThis picture changes to
indicate your choices.

Choose the page size you want from the Page Size pop-up
menu.

Use the Scaling feature to print your document larger or
smaller than normal. Use the pop-up menu to choose a preset
reduction percentage, or type a percentage from 5 to 999 in
the Scaling box. The percentages listed on the pop-up menu
give the best results for printing smaller than 100%.

The Orientation icons allow you to print your document in
normal (portrait) or sideways (landscape) orientation.

3. When you've made your choices, click OK.

Your document is now set up to be printed.

Chapter 2: Using Your Printer 13



Loading the sheet feeder

The sheet feeder holds up to 100 sheets of 20-b. paper. You can
use plain paper, letterhead, or three-hole punched paper. If you
use thicker paper, fewer sheets will fit in the sheet feeder.

/A Tmportant: Paper weight should be between 16 and 24 Ib;
20-Ib. cotton bond paper is recommended. &

You can load other materials into the sheet feeder, including
transparencies, labels, heavy (thick) paper (up to 28 Ib.), and up
to 15 business envelopes. Before you load envelopes or thick
paper into the sheet feeder, you must move the adjustment levers
to the envelope settings.

A\ Important: Insert only one kind of material at a time into the
sheet feeder. &
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To load the sheet feeder, follow these steps:
1. Set up the StyleWriter II as shown.

Move both levers to the paper icon (to load paper) or to the
envelope icon (to load envelopes or thick materials).

Move both levers to this
icon (€1) to load plain,
letterhead, and 3-hole
punched paper.

Pull the paper support to raise it.

i

7~
, S

TSR
" A =i

Move both levers to this
icon (=) to load envelopes
and thick materials.



2. Load paper or other material into the sheet feeder.

For best results, crease the leading edge of envelopes, as
shown, before you load them into the sheet feeder.

Crease this edge.

Move the adjustable guide so that it just touches the edge of
the stack of paper (or other material). If the stack bows out
even slightly, the guide is too tight.

Move the adjustable guide
to fit just against the paper.

o

Insert envelopes top first, with the
side to be printed facing front.

L

Insert 3-hole punched
paper face up with the
holes on this side.

Insert letterhead paper

face up with the top of
the page down.

Pull here if you want to open the output tray.
Be sure to pull it out all the way.

Chapter 2: Using Your Printer 15



Printing

You can print documents from within the application programs
you used to create them. You can also print documents from the
Finder desktop. And with a feature called background printing,

you can keep using your Macintosh computer while your docu-
ments are being printed.

Printing from within a program or from the desktop

To print a document from within an application program, or from
the Finder desktop, follow these steps:

1. Select the document you want to print.

Within an application program, open a document or create a
new one.

In the Finder desktop, click to select the icon of the docu-
ment you want to print.

2. Choose Print from the File menu.

In most cases a Print dialog box appears, with options for
printing your document. The dialog box may not look exactly
like the one shown here, but it will have the options shown in
this one.

% Note: Grayscale printing is not available on some Macintosh
computers, including the Macintosh Plus, Macintosh SE, and
Macintosh Classic. <
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Type the number of

copies you want in this

Stylelliriter|ll

i Print

caples:@ Pages: @ ANl O From: ITo: |_| Cancel

Print Quality: Qnast @Nnrmnl Qnruft ______ =

i

Paper Source: (@ Sheet Feeder | ©;Manual [ Help ]
Image:| Black & White w Options
Notification:[_None  w|

Choose Draft for speed, Click here for

Best for higher quality.

You can choose:

more information.

= the number of copies to print.

» the range of pages to print

s Draft quality for faster printing with lower quality, Normal
quality to balance speed and appearance, or Best quality
for finest quality at slower speed

s Black & White or Grayscale, to match the type of images
in your document (use Black & White for text)

= the notification you want when your document is printed
(you can choose to be notified by an Alert message that
appears on your screen or by a sound)

3. When the settings are the way you want them, click

Print.



Printing while you use your computer 3. Click the On button under Background Printing.

If you are using System 7 (or MultiFinder in System 6), you can

print with the StyleWriter II while continuing to work with one or Chooser
more programs. This is called background printing. If you use [G] | Connect to:
System 7, background printing is automatically turned on when g  <Serial Port>

you install your StyleWriter I1 software.

A Important: If your Macintosh computer has only 1 megabyte
(MB) of random-access memory (RAM), you won't be able to
use background printing. If vour computer has 2 MB of RAM | |

=
and you have trouble using background printing, turn off the Gt ) oekaround Printing
Share this Printer and Background Printing options, or quit : oo & oy
o O . S x 5 O PN e O Actjve On Restart
one or more of your open application programs. A . AppleTalk o e

To use background printing, you must turn it on in the Chooser.

Click here to turn on

1. Choose Chooser from the Apple (%) menu. Background Printing

2. Click the StyleWriter II icon.
4. Click the close box.

Once background printing is turned on, it is in effect whenever
you print, until you turn it off.

After you click Print in the Print dialog box, a message appears on
| the screen for a few seconds, then disappears. You can then

| continue other work. You may notice your Macintosh pause
occasionally while it processes the document for printing,

Chapter 2: Using Your Printer 17



Sharing your printer with other users 4. Click Setup.
on a network The Sharing Setup dialog box opens.
If your Macintosh is connected to other computers over an

AppleTalk network, you can allow other users on the network to
print on your StyleWriter II printer.

Click to place an X in this
bhox to share your printer.

% Note: This feature is not available on some Macintosh com- D@ styleWriter |1 Sharing Setup o
puters, including the Macintosh Plus, Macintosh SE, and
. ; e : —I[x] Share this Printer ;
Macintosh Classic. :!:;::i::r;a;g;g;:lg:;: ST har paope 10 e B prr |
#i - ; : ed Printer Type a name
[0 share vour StvleWriter II with other users, follow these steps: Hieme f'.' i
J 4 Pusswnrd:l:l.— (}I. },()llll
rinter here.,
1. Choose the Chooser from the Apple (®) menu. [JKeep Log of Printer Usage [
The Chooser window opens. |- (canfer ) C ok )
2. Click the StyleWriter II icon.
To keep a record of what To make your printer available
3. Click the icon of the port to which you connected the is printed, click here. only to people you choose,

StyleWriter II type a password here.
If vou used the Printer port to connect your Macintosh to

the network, you must connect the StyleWriter 11 to the 5. Click to place an X in the Share this Printer box.
modem port. If you wish, you can type a name for the printer and a pass-
word. If you type a password for the printer, only users who

know the password can use the printer from their computers.

18 Chapter 2: Using Your Printer
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e

If you want to keep a record of what is printed on your
printer, click to place an X in the Keep Log of Printer
Usage box.

To see what has been printed, you can open and print the log
file with the TeachText program, or with a word-processing
program. You can find the log file in the Printing Prefs folder.
The Printing Prefs folder is in the Preferences folder inside
vour System Folder.

Note: You can keep a log of your printer usage even if vour
printer is not shared. «

Click OK.

Click the close box to close the Chooser window.

Other users with Macintoshes connected to the network can
now use vour StyleWriter 1 printer (if StyleWriter I printer
software has been installed on their Macintosh computers as
described in Chapter 1).

Note: When other users print on a printer connected to your

Macintosh while you are using your computer, you may notice
vour computer pause occasionally, «

f

Printing on a shared printer on a network

If your Macintosh is connected over an AppleTalk network to
another Macintosh, and that computer has a connected
StvleWriter 11 printer set up to be shared, you can print on that
printer. (You must first install StvleWriter I1 software on vour
Macintosh, as described in Chapter 1.)

To print on a shared printer, follow these steps:
1. Choose the Chooser from the Apple (&) menu.
The Chooser window opens.

2. Click the StyleWriter II icon.

CONinues p

Chapter 2: Using Your Printer
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3. If necessary, click an AppleTalk zone. < Note: The fonts you use in your document must be available
(installed) on the Macintosh that is directly connected to the
shared StyleWriter IL If the fonts you use are not installed,
your document may not print properly. Click Get Info for
information about fonts available on the shared printer you
selected. <

If your network does not have zones, the list of AppleTalk
Zones does not appear.

Click to select the The available shared
StyleWriter IT icon. printers are listed here.

5. Close the Chooser window.

@ Chooser
You are now ready to print on the shared StyleWriter 11,

] | Connect to:
@ | & <Serial Port> O
AppleShare b

Alan's Printer Tips for printing
1 Kristan's StyleWriter |1
k& | W Ross’ Shared Printer
Eric’s printer
Mario’s public printer

Try these tips for best results with your StyleWriter I1:

AppleTalk Zones:

TR Phil's Stylewriter II | = lLega[-snze paper. When vou pr{m on paper longer than 11
Pam’s Design Zone 5 inches, close the output tray. (It's designed for paper no
; W Background Printing I ¢ 1ha inches 3
CGetinro 2ok dron e more than 11 inches long.)
® Active s Transparencies. Set both adjustment levers to the paper
SPRLSTIRIK QO Inactive ] ) 3
icon (¢1). When you print several transparencies, remove each
one from the output tray before the next one comes out of
If your network has If you want more

the printer. (This eliminates any chance of the ink smearing.).

zones, click on a information about a
name o select it shared printer, click here. = Envelopes. Set both adjustment levers to the envelope icon
(=2). Before loading envelopes into the sheet feeder, crease
4. Click the name of the printer you want to use. the top edge to make sure the flap is tightly folded..

If the printer requires a password, a dialog box appears in
which you must type the password.

20 Chapter 2: Using Your Printer



Chapter 3

Maintaining Your Printer

The StyleWriter ITis designed for trouble-free operation.
Maintaining the printer simply means replacing the ink cartridge
when it runs out, refilling the sheet feeder, and occasional
cleaning.

For other service, see the information about service and support
that came with your StyleWriter I1.

Safety first
Follow these safety tips to avoid damage to the StyleWriter IT

printer and harm to yourself and other users.

= Don’t move the carriage that holds the ink cartridge. You can
damage delicate moving parts.

= Don't touch the print head on the bottom of the ink cartridge.
Ink can leak out and cause stains.

= Don’t attempt to print anything when the access door is open;
this can cause paper to jam. Any time the door is open, keep
fingers away from moving parts.

= Don't oil the inside of the printer.
= Don'tattempt to disassemble the printer.

s Don't use ammonia-based or alcohol-based cleaners on or
around the printer—they may react with the plastic.

»  Before you unplug the printer, make sure it is turned off. (If
the green power light is on, press the power button.) Turning
the power off ensures that the carriage has been returned
securely to its home position.



Replacing the ink cartridge

Each ink cartridge lasts for several hundred pages, depending on
the kind of printing you do. If you print a lot of graphic images,
you may need to change cartridges more often.

To replace the ink cartridge, follow these steps:
1. Open the access door at the front of the printer.
Don't attempt to move the

carriage (the mechanism
that holds the ink cartridge).

These illustrations show how
to replace the ink cartridge.

22 Chapter 3: Maintaining Your Printer

. Open the package containing the new ink cartridge.
. Get the ink cartridge ready by following the

instructions that came with it.

. Raise the lever to release the old cartridge and

remove it.

See the instructions inside the door of the printer.

. Insert and lock the new cartridge.

See the instructions inside the door of the printer.

. Close the access door.

You have finished replacing the ink cartridge.



Cleaning the ink cartridge

If you experience problems with print quality, cleaning the ink
cartridge may improve your results. For examples of problems you
might experience with print quality, see “Image Problems” in
Chapter 4, “Troubleshooting.”

2\ Important: Cleaning the ink cartridge consumes a small
amount of ink. If you repeat the procedure unnecessarily, you
reduce the life of the cartridge. 2

To clean the ink cartridge, follow these steps:

1. When you are about to print a document, click Options
in the Print dialog box.

Stylellriter 11 10 rm
Copies: El Pages: @ All O From: I:, To: D
Print Quality: (QBest @ Normal O Draft P,
Paper Source: (@ Sheet Feeder :Manual
Image:| Black & White + |{lpt|uns
Notification:[_None  +|

Click Options.

The Print Options dialog box appears.

2. Click to place an X in the box labeled “Clean ink
cartridge before printing.”

Click to place an X in this box.

ﬂemﬂter 11 Print Options 10
&] Clean ink cartridge before printing

3. Click OK.
4. Click Print.

The StyleWriter II automatically cleans the ink cartridge before
printing your document.

. Important: After the StyleWriter II cleans the ink cartridge
and prints your document, the cleaning option is
automatically turned off. You do not have to turn it off
before printing again. -
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Cleaning the exterior

Before you clean the StyleWriter II printer, turn it off and unplug
the power cord. Then wipe the exterior of the printer with a
clean, soft cloth dampened with water. Be careful not to get any
liquid in the power cord receptacle.

A Warning: Don't use ammonia-based or alcohol-based

cleaners on or around the printer—they may react with the
plastic. a
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Cleaning the interior

Occasionally you may need to wipe off paper dust or spilled drops
of ink inside the StyleWriter I1. Before you clean the inside of the
printer, turn it off and unplug the power cord. Then gently wipe
the interior with a soft, dry cloth.

A Warning: Don't use any liquid cleaners inside the printer. A



Chapter 4

Troubleshooting

This chapter provides solutions to some common problems that
you may encounter while using your StyleWriter 11 printer.

As long as you follow the maintenance instructions in Chapter 3,
vou're not likely to have any problems with your StyleWriter 11,
The most common source of trouble is faulty software installation.
To avoid these problems, follow the instructions in Chapter 1.

A Warning: If you have a problem with your StyleWriter 11
printer and nothing presented in this chapter solves it, see the
information about service and support that came with the
printer. Do not attempt to repair the printer yourself! a

Safety precautions

Follow these safety tips to avoid damage to the StyleWriter 11
printer and harm to yourself and other users.

= Don’t move the carriage that holds the ink cartridge. You can
damage delicate mechanical parts.

»  Don't touch the print head on the bottom of the ink cartridge.
Ink can leak out and cause stains.

= Don'tattempt to print anything when the access door is open;
this can cause paper to jam. Any time the door is open, keep
your fingers away from moving parts.

= Don't oil the inside of the printer.
w  Don'tattempt to disassemble the printer.

= Before you unplug the printer, make sure it is turned off. (If
the green power light is on, press the power button.) Turning
the power off ensures that the carriage has been returned
securely to its home position.

o
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The Chooser doesn’t show the StyleWriter 11
printer icon

You use the Chooser desk accessory to identify the printer you
intend 1o use. If the StyleWriter 1 icon is missing from the box
that identifies different printer types, you probably need to install
the appropriate printer software. See the instructions in Chapter 1
for installing your printer software.

The Macintosh doesn’t recognize the
StyleWriter 11

If you have selected the StyleWriter 1T icon in the Chooser, but
nothing prints or you get a message that there is no StvléWriter 11
connected, one of the following conditions may be the cause:

» The printer has been turned off. Make sure it is plugged in
and turned on.

= Aplugis loose somewhere. Make sure that all the cables are
properly connected. See the instructions in Chapter 1 for
setting up your StyleWriter 11,

» Ifvou are trying to use a shared printer connected to another
Macintosh, make sure that the computer and shared printer
are turned on and connected to the network. Also make sure
that the printer is set up to be shared. See the instructions in
“Sharing Your Printer With Other Users on a Network™ in
Chapter 2.
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» The port selected in the Chooser isn't the same as the port
the printer is plugged into on the Macintosh. Try switching
from the printer icon to the modem icon (or vice versa) in the
Chooser.

There may be a problem with the printer software. Try turning
the printer off and then on again.

If you still can’t resolve the problem, the printer may not be
functioning properly. See the information about service and
support that came with your printer.

Text changes to the Geneva font

When vour Macintosh is low on memory, some fonts may be
displaved and printed in the Geneva font. Some text may also
look jagged on the edges rather than smooth.

For more information about fonts, and for suggestions on how to
free up memory, see the books that came with your Macintosh or
with vour latest system software upgrade. You can also see an
authorized Apple service provider about installing more memory
in your Macintosh.

If text changes to the Geneva font when you are printing on a
shared printer, the fonts in your document may not be available
on the Macintosh connected directly to the shared printer. Use
only the fonts installed on that Macintosh. For more information,
see “Printing on a Shared Printer on a Network™ in Chapter 2.



Paper is jammed

Occasionally a piece of paper may get jammed (stuck) inside the
printer during the printing process. To clear a paper jam:

1. If necessary, open the printer to see where the jam is.

2. Clear the jam.

Pull jammed sheets from the back of the printer whenever
possible.

Remove jammed paper
this way if you can,
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Paper feeds improperly The StyleWriter II won't print a particular

If paper tears, gets skewed, or comes through the printer document
crumpled, it may not be entering the printer properly. Try the

: If you attempt to print a document and no page is printed, try the
following steps:

following steps:

= Make sure you have loaded the sheet feeder correctly. = Check for messages on your Macintosh screen.

" s e M 9 far laadi Ane .
See the instructions in Chapter 2 for loading paper. = Check the printer.

= Do not overload the sheet feeder. Does it have paper? (To load paper, see Chapter 2.)
The feeder holds up to 100 sheets of 20-Ib. paper. If you use

heavier paper, fewer sheets will fit in the feeder. Don't insert
too much paper in one stack.

Is the paper jammed? (To clear a jam, see “Paper Is Jammed"
earlier in this chapter.)

Do the lights indicate a problem? (To check the lights, see the

w Try to recover any torn or damaged pieces of paper next section.)

from the printer.
= Repeat the printing process.
See “Paper Is Jammed” earlier in this chapter.
Sometimes problems disappear when you try to print your

= Take the paper out of the sheet feeder and check it. document again.

Try flipping the stack over to print on the other side (most
paper has one side that prints better).

Fan the paper to make sure sheets don’t stick together.
Make sure none of the sheets are bent or dog-cared.

Make sure the edges of the stack line up evenly.
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The lights indicate a problem

Sometimes the lights on the printer can signal a problem. The
following list describes these indications and tells what you should
do about them.

= Both lights are off. Check to make sure the power cord is
plugged in properly and the printer is turned on. Make sure
there is power to the outlet. If the lights stay off, see the
information about service and support that came with the
printer.

m The error light glows steadily. Either the printer is out of
paper or paper has been misfed. Check your Macintosh
screen for messages. See Chapter 2 for instructions on loading
the sheet feeder, or “Paper Is Jammed” and “Paper Feeds
Improperly” earlier in this chapter.

Image problems

Most of these result from problems with the ink cartridge or with
your choice of paper. Here is a list of papers to avoid:

= coated, extremely thick, or shiny paper (because the paper
may not properly absorb the ink)

m erasable typing paper

= damaged or wrinkled paper
n stapled paper

= multipart forms

For best print quality, use 16-Ib. to 24-Ib. cotton bond paper.
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Image is too light or too dark

If printing looks fuzzy because it’s too light or too dark, try the fol-
lowing:

= Clean the ink cartridge. If this doesn't help, replace the car-
tridge. See “Cleaning the Ink Cartridge” and “Replacing the
Ink Cartridge” in Chapter 3 for instructions.

m Ifthe problem occurs on nonstandard paper, try printing on
the recommended 16-Ib. to 24-Ih. cotton bond paper.

m Ty flipping the stack of paper in the sheet feeder. Most paper
has one side that prints better.

»  Make sure that both adjustment levers are set to the proper
icon (€1 for 16-Ib. to 24-lb. paper and transparencies;
= for envelope and paper heavier than 24-1b.). See “Loading
the Sheet Feeder” in Chapter 2 for instructions.
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Printing appears on only part of the paper

Make sure you have selected the appropriate paper size in the
Page Setup dialog box.

The ink cartridge may need to be cleaned, or it may be empty. See
“Cleaning the Ink Cartridge” and “Replacing the Ink Cartridge” in
Chapter 3 for instructions

Text does not print correctly

If the text in a printed document looks “jagged” on the edges, or
is not spaced properly on the page, try the following:

= Change the size of the font you used in the document.

= Use a different font in your document. For best results,
choose a TrueType font. In an application program, you can
find out if a font is a TrueType font by choosing the font and
looking at the list of available sizes (for example, in the Size
menu). Truelype fonts are available in all sizes.

s Ifthe problem occurs only with a particular application pro-
gram, contact the publisher of that application.

= If the problem occurs with more than one application pro-
gram, install your printer software again (follow the instruc-
tions in Chapter 1).



A page prints off center or images are out of place
This problem may be a result of one of the following conditions:

= You may have selected the wrong page size in the Page Setup
dialog box.

» The margins may be set incorrectly in the document you are
printing.

m The sheet feeder is too full.

= Paper is not placed properly in the sheet feeder. See “Paper
Feeds Improperly” earlier in this chapter.

= You are not using the recommended paper (16-b. to 24-Ib.
cotton bond).

Inke smears when rubbed

Don't handle pages before they are completely ejected from the
printer and are delivered into the output tray. This allows all the
time needed for the ink to dry.

Nothing prints on the paper

If you get a blank page, clean the ink cartridge. See “Cleaning the
Ink Cartridge” in Chapter 3.

If that doesn't work, replace the ink cartridge. See “Replacing the
Ink Cartridge” in Chapter 3.

Unwanted lines or stripes appear
If white lines appear on the page, try the following:

m  Clean the ink cartridge. See “Cleaning the Ink Cartridge” in
Chapter 3.

m Take the cartridge out and install it again to make sure it is
secured properly.

= Replace the ink cartridge. See “Replacing the Ink Cartridge” in
Chapter 3.
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Stains appear on printed pages Image prints wavy or distorted

If stains appear on the backs or tops of printed pages, it may Wavy or distorted images usually mean that your StyleWriter 11
mean that there is ink inside the printer. If so, the ink can transfer requires service. Try cleaning the ink cartridge. (See “Cleaning the
to the rollers and from there to the paper. Ink Cartridge” in Chapter 3.) Also check the setting of the

adjustment lever inside the printer (above the ink cartridge). If
the problem persists, see the information about service and
support that came with the printer.

Turn the printer off and unplug it. Then open the printer and
carefully clean the rollers and platen with a soft, dry cloth.

Clean the rollers with
asoft, dry cloth. Clean the platen.
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Appendix

Specifications

Marking engine

m  Thermal ink jet

Resolution

m 300 dots per inch (dpi) for text and graphics (180 dpi in draft
mode)

Speed

= Up to3 pages per minute in draft mode

m  Up to 2 pages per minute in normal mode

= Up to 1.5 page per minute in best mode

m  Actual speed depends on the images printed and on the
Macintosh used.

Interface

m  Apple-style RS-422 asynchronous serial

Paper feed

= Automatic sheet feeder holds up to 100 sheets of 20-b. (75

g/mz) paper or 15 envelopes.

Printing materials

Apple recommends 20-Ib. cotton bond (75 g/mz) paper. You
can use 16-Ib. (60 g/mz) to 24-Ib. (90 g/mz) paper.

Accepts most letterhead and colored stock.

Accepts medium-weight photocopier labels.

Use #10 business envelopes: 243.5mm x 105.8mm (9.5" x
4.125").

Apple recommends 3M brand CG3480 transparency film.

Paper sizes

U.S. letter: 215.9mm x 279.4mm (8.5" x 11")

U.S. legal: 215.9mm x 355.6mm (8.5" x 14")

Executive: 184.2mm x 266.7mm (7.25" x 10.5")

A4 letter: 210mm x 297mm (8.3" x 11.7")

Monarch envelopes: 104.1mm x 241.3mm (4.1"x 9.5")

#10 envelopes: 241.3mm x 104.8mm (9.5" x 4.125")
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Imageable area

s Maximum printable line: 203.2 mm (8.0").

= Minimum top and bottom margins: 6.25 mm (0.25").

= Minimum left and right margins: 6.35 mm( 0.25").

= Actual imageable area may vary depending on the application
program.

Dimensions

» Height (paper support down): 18 cm (7")

w Width: 34.5 cm (13.6")

= Depth (output tray closed): 20 cm (7.9")

Weight

Operating environment
Temperature

x 15°1030°C (59°t0 86°F)
Humidity

= 20 to 70 percent, noncondensing
Other

n  Keep the printer away from wind and fans.
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Input electrical requirements
U.S./Japan

s 90-128 VAC, 48062 Hz
Europe/UK/Australia

= 198-264 VAC, 48—52 Hz

Power consumption
Operating

‘ 195 Wmaximumat 120V
w18 Wmaximumat 220V
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menu commands. See commands
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printer
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software. See application software; printer
software; system software
specifications
paper 14, 33
printer 33—34
system 1
speed specifications 33
stains on printed page 31
status lights 8, 29
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The Apple Publishing System

This Apple manual was written and edited on a desktop publishing system using Apple
Macintosh computers. Proof pages were created on Apple LaserWriter printers and on
the QMS ColorScript 100 color printer. Final pages were produced in QuarkXPress and
output directly to separated film on an Agfa SelectSet 7000 imagesetter. Line art was
created with Adobe Illustrator. Cover art was procluced with Adobe Photoshop. Screen
shots were created and modified with system software, Exposure, and MacPaint 2.0.

Text type is Apple’s corporate font, a condensed version of Garamond. Ornaments are
ITC Zapf Dingbats® and custom symbols designed for Apple Computer.

PostScript®, the LaserWriter page-description language, was developed by Adobe
Systems Incorporatec.
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